
 
 

MAPPING FUNDAMENTALS 
 

About 

Syllabus 

Introduction to Spatial Data and Mapping (1 hour lecture) 

● Definitions of terms (maps, mapping, geography, geodata, spatial data) 

● Overview of mapping and its applications 
History of Mapping (3 hours lecture) 

● Early maps and cartography 

● Key developments in the history of mapping 

Types of Maps (3 hours lecture) 

● Physical, political, thematic maps, topographic maps 
Map Elements (3 hours lecture, 1 hour exercises) 

● Labels, annotations, symbols and their meanings, legends and scale bars 
Map Projections and Coordinate Systems (2 hours lecture, 2 hour exercises) 

● Types of map projections 

● Distortions and their implications 

● Geographic vs. cartesian coordinate systems 
Spatial Data Acquisition Methods (2 hours lecture, 2 hour exercises) 

● Ground surveying techniques, GNSS and Remote sensing basics 

● Aerial photography, satellite imagery, LiDAR (Light Detection and Ranging) 
Using Maps (3 hours exercises) 

● Reading and interpreting maps 

● Map navigation skills 

● Application of maps in various fields (e.g. urban planning, environmental management) 
 
The homework will include: 20 hrs literature analysis, mapping terminology, and individual study. 
 

Objectives and Competences 

Course Objectives: 

● To provide foundational knowledge of spatial data and mapping. 

https://vetfarm.org/


● To introduce students to the various types of maps and their uses. 

● To teach the principles of coordinate systems and map projections. 

● To explore the history and evolution of mapping. 

● To familiarise students with the methods and technologies used in spatial data acquisition. 
Competences: 

● Ability to interpret and create maps using appropriate symbols and labels. 

● Understanding of coordinate systems and the ability to apply map projections. 

● Knowledge of the different types of maps and their specific applications. 

● Proficiency in basic spatial data acquisition techniques. 
 

Intended Learning Outcomes 

Students that will successfully attend the course will be able to: 

● Explain the fundamental concepts of spatial data and mapping. 

● Identify and use different types of maps and their elements (labels, symbols). 

● Describe the history and development of mapping. 

● Apply coordinate systems and map projections. 

● Differentiate between various spatial data acquisition methods. 

● Utilise maps effectively for various applications. 

Course content 

Introduction to Spatial Data and Mapping 

Geography is the study of places, landscapes, environments, and the relationships between people 
and their environments. 
Data are facts and statistics collected together for reference or analysis. 
Spatial data refers to data which cover more than one spatial dimension (2D, 3D, …). 
Geographic data (shortly geodata) are data representing features or phenomena related to the 
Earth. 
Map is a downscaled and simplified drawing of the earth’s surface, or part of that surface. 
Mapping in this context means a process of making a map. Beware that this word may have 
different meanings in different fields, like in mathematics. 
 
Mapping can be also described as the process of creating visual representations of geographic data, 
transforming raw facts and statistics into understandable, spatially-organised information. It is 
invaluable for studying geography, as it helps illustrate the relationships between people, places and 
environments. By representing spatial data and geodata in the form of maps, mapping makes it 
easier to analyse and interpret the Earth's features and phenomena. Applications of mapping are 
diverse, including urban planning, environmental conservation, transportation logistics, disaster 
response and resource management, all of which benefit from clear, accessible visualisations of 
complex geographic data. 

Quiz 

match a term with its description 
 

map downscaled or simplified drawing of the earth’s surface, or part of that 



surface 

mapping a process of making a map 

spatial data data which cover more than one spatial dimension 

geography the study of places, landscapes, environments, and the relationships between 
people and their environments 

geographic data data representing features or phenomena related to the Earth 

 

History of Mapping 

We have already learned a definition of what a map is. But how do we distinguish a map from a plan 
or a sketch, or a simple drawing? That is a rather philosophical question. What is known is that 
people used to draw maps (or plans, geographical sketches, …) long before the word “map” was 
even introduced. One of these oldest relics which we may call a map, is an engraving on a Mammoth 
tusk – a plan of meanders of river Thaya in the south Moravia, also depicting a camp of the 
indigenous people. This engraving probably dates at least 20 000 years into history. 

 
Mammoth tusk engraving map, Petr Novák, Wikipedia 
 
One notable example of a very old map (or “map”), is the so-called Mappa di Bedolina – one of the 
earliest maps, which survived till the current era. As with other very old maps, it is hard to tell its 
actual age, due to its unknown date of origin. It is believed that it was created around 1000 BCE. 
Mappa di Bedolina is a 4 metres length plan of the valley around Bedolina, Lombardy. Another 
example of a map this old is a city plan of Babylonian city Nippur. 

 
Mappa di Bedolina, Luca Giarelli / CC-BY-SA 3.0 



 
Map of the Babylonian city of Nippur. https://imgur.com/map-of-babylonian-city-of-nippur-ca-1500-

bce-this-is-earliest-known-city-map-drawn-to-scale-lWuI7RR 

 
If the aforementioned old maps had a scale, we could call them all large-scale or middle-scale maps 
– they only covered a small piece of the Earth’s surface. That is due to the fact that the area known 
to their authors was quite limited. Since then, as the human population grew and the ancient 
civilizations expanded, maps covering larger areas have appeared. As a result of the continuous 
discovery of the Earth by these civilizations, first maps of the known world were created. 
Notable is the Anaximandros’ map of the world. The actual map was not preserved to the current 
times, but it is known that its shape and design affected many maps created afterwards. We call 
them “round maps”, as they have a circular shape. 
One of these maps, which survived until the current era, is the Hereford Mappa Mundi map, created 
around 1280. It depicts known continents – Europe, Asia and Africa. It has Jerusalem in the centre of 
the map and it is oriented such that east is on the top of the map and north is on the left side. The 
Hereford Mappa Mundi depicts locations from Ganges river in the east to the Strait of Gibraltar to 
the west and from the Baltic sea in the north to the River Nile in the south. 



 
Anaximander world map. Probable reconstruction. 
 

 
Hereford Mappa Mundi. 
 



The eastern orientation of the old “world” maps was typical, due to the east was considered the 
direction to heaven. The northern orientation of maps, which is common nowadays, emerged later. 
Mediaeval maps called Portolan charts were using the northern orientation. These maps were 
produced from the 13th century onward. Their purpose was for nautical navigation. They are known 
for their precise depiction of coastlines and for the fact that loxodromes (rhumb lines) are displayed 
as straight lines on the map. Oldest known of these Portolan charts is Carta Pisana. 

 
Carta Pisana. The preserved piece. 
 
In the late 15th century, Martin Beheim created his globus, a spherical depiction of the earth 
surface. It was not the first globus ever created, it is known that globes existed in the antique times, 
but the globe by Martin Beheim is the oldest one which was preserved until today. 
 



 
“Erdapfel” – the globe of Martin Beheim. 
https://commons.wikimedia.org/wiki/File:Behaims_Erdapfel.jpg 
 
In the 16th century, cartography was significantly influenced by the mathematician Gerhard 
Mercator. Mercator created a number of maps, globes and atlases. He is also considered the author 
of the word “atlas” in the cartographic meaning – a collection of maps sharing a similar composition 
and reflecting a certain shared theme or describing a certain region. Gerhard Mercator has also set 



base for the field of mathematical cartography (more on mathematical cartography in the chapter 
“Map Projections and Coordinate Systems”). 
 
Further developments in mapping were vastly affected by the invention of letterpress printing and 
the expansion of printing techniques. Printing made the reproduction of maps significantly easier. 
Prior to that, maps were manually redrawn, piece by piece, making every map de facto original. 
 
Maps gained better precision through the centuries as the measuring techniques improved and the 
understanding of the Earth’s shape and size evolved. In the 16th century first measurements of the 
Earth’s meridian (called an “arc measurement”) were done in France – a technique of counting the 
revolutions of a spinning wheel of a carriage was used to measure the distance from Paris to Amiens. 
The circumference of the whole meridian (and the Earth) was then calculated. The invention of the 
telescope in the 17th century allowed surveyors to precisely measure angles between distant 
objects and the technique called triangulation made it possible to calculate distances between 
distant objects. The “arc measurements” were later repeated in the 18th century with more modern 
measuring devices and leveraging the triangulation technique in Ecuador/Peru and Lapland, further 
improving the calculation of the Earth’s circumference. 
 
In 1791 metre was officially defined as a base unit for measures of distances, which also helped to 
improve the precision of maps. During the 18th century Josef Liesgang made significant 
trigonometric measurements with a proper stabilisation of geodetic points. His measurement of a 
meridian arc stretched from Moravia (Czechia) to Croatia. 
 
First road atlas, called Britannia Atlas, was created by John Ogilby in the 17th century.

 
John Ogilby’s Britannia Atlas. Road from London to Bristol. 
 



First map with isolines was created by Edmond Halley. Isolines are lines which connect places with 
the same value of a certain phenomenon. Halley’s map was depicting a magnetic variation. The 
method of isolines then gained popularity. Alexander von Humboldt used the isolines to show places 
with the equal temperate, thus creating a first map with isotherms. Phillipe Buache then made a 
map of France on which contours were first used – isolines connecting places with equal height. 
Before Buache’s innovation, the height on maps was shown with a simple method of “hills” or 
“forests” or the slope was illustrated with hatching. 
 

 
Edmond Halley's New and Correct Chart Shewing the Variations of the Compass 
 
Another significant development which affected the cartographic works, was the invention of 
coloured print in the 18th century. 
 



Notable colourful map is a geological map of Britain by William Smith from 1851. Geological maps 
were created before, but this one is the basis for nowadays geological maps. 
 

 
William Smith’s geological map. https://www.nhm.ac.uk/discover/first-geological-map-of-
britain.html 
 
Pierre Charles Francois Dupin is the author of the first modern statistical map. It depicts education 
and literacy in France and was published in 1826. The method used by Dupin, colourizing regions 
with a different tint of colour based on a relative value, is known as a choropleth map. Dupin then 
created more statistical maps of France for other socio-economic phenomena, while using other 
methods of thematic cartography like graduated symbols. 



 
Statistical (choropleth) map by Pierre Charles Francois Dupin. 
https://www.researchgate.net/publication/269498551 
 
Several years later, in 1854, John Snow created his famous dot map. This map shows cholera cases 
during the disease outbreak in London as individual dots. When created, it helped localise poisoned 
wells and even uncovers the spatial relation between water wells and cases of disease. That cholera 
event and the work done by John Snow are considered the basics of epidemiology. 



 
John Snow’s map from “On the Mode of Communication of Cholera”. 
 
An innovative approach in creating thematic maps was introduced by Charles Joseph Minard in 
1869. He portrayed Napoleon’s march against Russia as a single line changing its thickness. The 
thickness represents the number of soldiers in Napoleon’s army in a given place and time. This type 
of map was later called a flow map and Minard’s map was one of the first. 



 
Charles Minard’s chart of Napoleon’s campaign against Russia in 1812. 
 
From the mid 18th to the mid 19th century, many cadastral maps were produced in Europe. These 
detailed maps of land were often based on very precise geodetic measurements, notably in Austria-
Hungary. Along with the cadastral maps, detailed maps for military purposes were also produced. 

Quiz 

Recognise the following significant old maps: 

⚫ Mappa di Bedolina 

⚫ John Snow’s dot map 

⚫ Hereford map 

⚫ Pierre C. F. Dupin’s statistical map 

 



 
 

Types of Maps 

Maps can be divided into two major groups: Reference (base) maps and thematic maps. The primary 
difference between reference maps and thematic maps is in their purpose and the information they 
convey. 
Reference maps are designed to show the location of geographic features, such as boundaries, 
cities, and physical landscapes, providing a general understanding of an area’s layout; examples 
include political, physical, and topographic maps. 
In contrast, thematic maps highlight a specific theme or topic over a geographic area, such as 
temperature, population density, or resource distribution, by overlaying this data onto a base map. 
While reference maps emphasise locations and boundaries, thematic maps focus on communicating 
patterns or trends related to a particular subject. 
 
Physical maps are designed to show the natural landscape features of Earth. They are best known 
for showing topography, either by colours or as shaded relief. 



 
Physical map of North America, Mapswire / CC-BY 4.0 
 
Political maps are among the most widely used reference maps. They show the geographic 
boundaries between governmental units such as countries, states, and counties. To distinguish the 
governmental units, each unit is painted in a different colour. Political maps may show roads, cities 
and major water features such as oceans, rivers and lakes. Political maps help people understand the 
geography of the world. They are mounted on the walls of classrooms throughout the world and 
they are usually the first type of map that students are introduced to in school. 



 
Political map of North America. https://www.burningcompass.com/continents/north-america/north-
america-political-map.html 
 
Topographic maps are reference maps that show the shape of Earth’s surface. They usually do this 
with lines of equal elevation known as "contour lines", but elevation can also be shown using colours 
(second map), colour gradients, shaded relief and a number of other methods. Topographic maps 
also show other important natural features such as lakes, rivers and streams. Important cultural 
features are also shown on topographic maps. These include roads, trails, buildings, place names, 
bench marks, cemeteries, churches, schools and much more. A standardised set of special symbols 
has been developed for this use. Topographic maps have traditionally been printed on large sheets 
of paper with their four boundaries being lines of longitude and latitude. 



 
Soviet military mapping – topographic map of the Elbrus mountain.  
https://maps.vlasenko.net/smtm100/k-38-013.jpg 
 
An orthophotomap is a high-resolution aerial photograph that has been geometrically corrected, or 
"orthorectified," so that it accurately represents the Earth's surface, with uniform scale throughout. 
Unlike standard aerial photographs, which can have distortions due to camera angles, terrain, or 
elevation, orthophotomaps align with a specific map projection, allowing for precise measurements 
of distance, area, and angles directly from the image. These maps combine the visual detail of a 
photograph with the spatial accuracy of a map, making them useful for applications in urban 
planning, environmental monitoring, and geographic analysis. 
 



 
Orthophotomap of a town in Czechia. 
 
A thematic map is a type of map that portrays the geographic pattern of a particular subject matter 
(theme) in a geographic area. This usually involves the use of map symbols to visualise selected 
properties of geographic features that are not naturally visible, such as temperature, language, or 
population. 



 
A thematic (choropleth) map visualising proportion of black and hispanic population in the United 
States as of 2010. Bplewe / CC-BY-SA 4.0 
 
Source for this lecture: https://geology.com/maps/types-of-maps 

Quiz 

Categorise maps by image 
⚫ Orthophoto 
⚫ Political map 
⚫ Physical map 
⚫ Topographic map 
⚫ Thematic map 

https://geology.com/maps/types-of-maps


 



Map Elements 
A proper map consists at least of: 

● map image, 

● title, 

● scale, 

● legend, 

● north arrow, 

● imprint. 
These are the so-called composition elements and together they form a map layout, also known as a 
map composition. 
We are going to investigate an example map and decompose it into individual elements. 
 

 
A map with proper composition: Map image, title, scale, legend, imprint and north arrow.  
 
Map image is the core part of the whole map. It is the spatial data interpreted with a certain 
cartographic technique to convey an information, a message or a point of view. Yet the map image 
itself cannot convey any meaningful information on its own. As you can see on the picture below, if 
the map image is not accompanied with other elements, the content of the map would be a pure 
guess. 



 
Map image without any other composition elements. 
 
The first element that helps the map reader to understand the content of the map is a title. Title 
shall be brief but also descriptive and specific. Typically, there is no reason for the map to have the 
word “map” in its title. A good tile might be e.g. “Crop production in Benin in 2020” or “Trujillo from 
satellite”, while bad examples might be “Map of crop production” or “What a detail! The image from 
the sky shows every street of our city. Can you find your house?”. 
If the title would be too long, it is a good idea to split the headline, so it is displayed as a title and a 
subtitle. In such a case, the title gives the reader a coarse idea of what is the topic of the map and 
the subtitle specifies the topic in a little more detail. In the digital era, maps are often presented as 
web pages. In such a case, map title can be displayed as a regular page title in the web browser. 



 
A brief title gives a coarse idea what the topic of the map is. It is further specified in the subtitle. 
 

 
Interactive digital map presented as a web page with title highlighted. 
 
While a title explains what is displayed in the map, legend explains how it is displayed. Through the 
charts, textual explanations and map symbols, the reader shall understand all the content visible on 
the map. With the use of the legend, the reader shall be ultimately able to read the map and to 
understand it. Usually, there is no good reason to headline a legend with the word “Legend”. 



 
The example map contains three legends as it displays three types of information: a) the ratio of the 
council seats each party occupies depicted as a fraction of a circle (graph), b) the size of the city 
council as a number of seats represented as as size of the circle (graph) and c) specific parties 
represented by their associated colour in the graphs. 
 
Imprint is a brief description of the map’s author, date of creation, source of map’s spatial data, 
copyright, etc. In the digital world, imprint is usually replaced with metadata records. 
 

 
The imprint of the example map is quite generous. 



 
The scale of a map is the ratio of a distance on the map to the corresponding distance on the 
ground. Scale can be represented as a numeric value (e.g. 1:10 000) or as a graphical scale-bar. 
Rarely, it can be described using words. Scale and north arrow can be omitted if a geographic 
graticule is present over the map. Numerical scale is also not appropriate for largely distorted maps 
(see lecture “Map Projections and Coordinate Systems”). 
 

 
On the example map, the scale is depicted as a graphical bar. 
 
As mentioned in the lecture “History of Mapping”, the orientation of maps has evolved. Nowadays, 
we can generally see two orientations: 

⚫ to the north or 
⚫ to the direction of the viewer. 

The former is the most common orientation of printed maps, while the latter is a popular option for 
digital interactive maps in handheld devices like mobile phones or smart watches. Especially in the 
case the map is static (printed), a north arrow is an important element, as it helps the reader to 
orient the map into a direction which corresponds with the world around them. North arrow can be 
displayed in various shapes from a simple arrow to more complex symbols. It might be accompanied 
with a letter “N” or the word “north”. Some maps do not contain a north arrow, when they display 
the whole world or continent, which is expected to be known to any potential reader, especially with 
the standard orientation having the north on the top. In cases like this, a north arrow is considered 
redundant. 

 
An example of a north arrow. 
 



Additionally, the map layout can be enriched with other composition elements like images, charts, 
texts, inset maps, etc. 
 

 
This map has one additional composition element: an illustration (image / logo) to the topic. 
 
Map image itself usually comprises various elements: labels, annotations, symbols. The set of all 
symbols, marks and colours used in the map is called a symbology of the map and is explained 
through the map legend. 

Quiz 

Match element with its graphic representation 

● title, 

● scale, 

● legend, 

● north arrow, 

● imprint. 

Map Projections and Coordinate Systems 

Map projection is a technique used to display the spherical shape of the Earth on a flat surface. It’s a 
conversion of the 3D shape of Earth to 2D form. There are endless variants of how a map projection 



can project the earth surface on a plane. Every map projection must grow or diminish some 
characteristics, including size, shape, distance, direction, and/or scale. 
 
Maps inherently involve distortions because it is impossible to perfectly unfold the surface of a 
three-dimensional globe onto a two-dimensional plane. When a globe is projected onto a flat 
surface, some aspects of the map must be distorted, whether it be shape, area, distance, or 
direction. Different map projections preserve different metrics to suit specific purposes. However, 
no single projection can preserve all these properties simultaneously, which is why different 
projections are used depending on the map’s intended purpose. 
 
There are three main groups of projections depending on a property they preserve: 

⚫ Conformal projections (like the Mercator projection) preserve angles and shapes locally, 
making them useful for navigation. 

⚫ Equal-area projections (like the Mollweide projection) maintain area accuracy, ensuring that 
the relative size of regions is correct. 

⚫ Equidistant projections (like Plate carée) preserve distances along certain lines. 
 
Beside that, a map projection can be constructed in such a way that none of the above-mentioned 
properties are preserved, but distortions of all of these are somewhat minified. These are called 
compromise projections. 
 
 



 
Some common map projections / Maximilian Dörrbecker, CC BY-SA 3.0. 
 
 
How a certain projection distorts shapes can be observed on a circle with a fixed diameter when 
drawn on multiple places over the map. Such a circle is called a Tissot indicatrix. Under conformal 



projections, the Tissot’s indicatrix remains circle, but its size is variable across the map. Under equal-
area and equidistant projections, the Tissot’s indicatrix can be a circle on certain places, but in most 
places distorts to an ellipsis. 

 
Mercator projection with Tissot’s indicatrix. https://map-projections.net/tissot.php 
 
A coordinate system is a method used to identify the exact position of a point in space using 
numbers called coordinates. In simple terms, it assigns a set of values (commonly marked as "x", "y" 
, …) to each point, helping us locate where something is. For example, in a 2D space, the "x" 
coordinate tells us how far left or right a point is, and the "y" coordinate tells us how close or far 
away. 
 
A spatial reference system (SRS) or coordinate reference system (CRS) is a framework used to 
precisely measure locations on the surface of Earth as coordinates. A particular SRS specification 
comprises a choice of Earth ellipsoid, horizontal datum, map projection, origin point and unit of 
measure. As possibilities of how an Earth’s surface can be projected to a plane are endless, there are 
endless ways to define a spatial reference system. Thousands of various SRS have been specified for 
use around the world or in specific regions and for various purposes. As a consequence, 
transformations between different SRS are often required. 
 



We can divide spatial reference systems into two groups depending on whether they work with 
geographic (spherical) coordinates or if they work in projected space with cartesian coordinates. A 
geographic coordinate system represents the Earth as a perfect sphere and any place on the Earth 
surface can be described by two numbers denoted by greek letters λ and φ. λ is called longitude and 
φ is called latitude. Longitude and latitude are angles in degrees  and can only take on certain values. 
Longitude values are restricted from -180 to 180, while latitude values are restricted from -90 to 90. 
In this representation, negative longitude represents the western hemisphere and positive longitude 
represents the eastern hemisphere. Similarly, negative latitude represents the southern hemisphere 
and positive latitude represents the northern hemisphere. Alternatively, the hemisphere can be 
denoted by a big letter after the value like 49° N stands for latitude 49 degrees north or 15° S means 
latitude 15 degrees south. A point exactly in the cross-section of the main meridian and the equator 
is on neither hemisphere and its geographic coordinates are [0,0]. This point can be theoretically 
anywhere, but in the most commonly used geographic coordinate system WGS84, it is in reality 
inside of an Atlantic ocean, thus it does not point to any special place. 
 
A great circle with a constant longitude is called a meridian. A prime meridian is a meridian with 
longitude equal to 0. Most widely known is the Greenwich prime meridian, yet others have been in 
use historically and even nowadays. A great circle with latitude equal to 0 is an equator. Circles 
parallel to the equator are called parallels or circles of latitude. 

 
Earth as a sphere with meridians and parallels in blue, equator as a red line and latitude and 
longitude angles in black. 
 
Most commonly used SRS with a geographic coordinate system is WGS84, a realisation of the World 
Geodetic System standard. 
 
While a geographic coordinate system defines locations on a spherical surface, a cartesian 
coordinate system (also known as projected coordinate system) represents locations on a flat, two-
dimensional surface. The Earth’s surface (or a piece of it) is projected on a plane using one of the 
map projections. Most common cartesian coordinate systems are based on a Mercator projection, 
like the UTM (Universal Transverse Mercator) or Web Mercator. Even a Pulkovo 1942 system is a 
cartesian coordinate system using Gauss-Krüger projection, which is also a variant of Mercator 
projection. 



 
To identify coordinate systems (both geographic and cartesian), projections and mutual 
transformation without confusion, a unique database called EPSG exists. It references all common 
coordinate systems, projections etc. by an “EPSG:” string followed by a numeric code. E.g. WGS84 
system has EPSG code EPSG:4326, while Web Mercator has code EPSG:3857 and Pulkovo 1942 has 
code EPSG:4284. These codes are used to identify coordinate systems in geographic information 
systems (GIS) but also elsewhere. 
 

Quiz 

Match a projection with its description 

 
⚫ Preserves angles, distorts sizes 

 
⚫ Preserves sizes, distorts lengths 

 

Spatial Data Acquisition Methods 

From all spatial data acquisition methods, ground surveying has the longest history. As mentioned in 
the chapter “History of Mapping”, first measurements of the Earth involved measuring distances 
between not so distant places. A groundbreaking measurement was done by Eratosthenes of Cyrene 
in the 3rd century BCE. Eratosthenes used only primitive tools available at that time: a gnomon and a 
wheel. Gnomon is a simple pole placed perpendicular to the earth surface. By measuring the 
revolutions of a wheel of Eratosthenes carriage and the length of a shadow casted by gnomon on 
two different places, Eratosthenes was able to calculate quite precisely the Earth’s circumference 
more than 2200 years ago. His approach inspired much later measurements in 16th century France. 
 



When better and more precise instruments were invented, the measurements of earth also 
improved. Josef Liesgang in the 18th century used a telescope to measure angles between objects 
on an observable horizon. By also measuring a distance in several places, he was able to construct 
imaginary triangles of known sizes. Vertices of these triangles were well identified locations on hills 
or at build-up structures, like a cathedral tower. In principle, the same method is used up until today. 
An instrument named theodolite was a principal tool for measuring angles in the 19th and 20th 
century and is still used for simple tasks at construction works today. Theodolites were lately 
superseded by electronic total stations, an instrument capable of measuring both angles and 
distances at the same time. Nowadays total stations are robotic, meaning they can turn in a desired 
direction by a remote control. They are also often combined with GNSS aparatures in order to 
calculate the most accurate results in the field, without further post-processing, which is essential 
for smooth work on construction sites. 
 
Global Navigation Satellite Systems (GNSS) work by determining the precise location of a receiver 
on Earth through the use of satellite signals. The basic principle behind GNSS relies on measuring the 
time it takes for a signal to travel from a satellite to a receiver. Each GNSS satellite continuously 
transmits signals that include the satellite’s position and the precise time the signal was sent. The 
receiver on the ground records the time at which the signal was received. By calculating the time 
difference between when the signal was emitted and when it was received, the receiver can 
determine its distance from that satellite. 

Since the receiver only knows its distance from the satellite (and not the direction), it could be 
located anywhere on a sphere with that radius. To accurately pinpoint its location, the receiver 
needs signals from at least four satellites. When data from these satellites are combined, the 
receiver calculates its position through a process called trilateration. The intersection of spheres 
from multiple satellites allows the receiver to determine its exact position in three dimensions 
(latitude, longitude, and altitude). This process accounts for time discrepancies by solving for both 
the receiver's position and the receiver's clock error, making GNSS an accurate and reliable method 
for global positioning. 

First GNSS system was an American military system NAVSTAR GPS or shortly just GPS. Its positional 
accuracy was initially obscured for civil usage and location with sub-metre accuracy was only 
available for military applications. Civil receivers were only able to determine its location with a 
precision of several metres. This obfuscation of NAVSTAR GPS was removed in 2000. With the 
evolution of GNSS receivers for public geodetic users, a positional accuracy of several centimetres is 
possible. This is thanks to the approach of using phase measurements of the GNSS carriage wave. As 
of 2024, four GNSS systems are fully operable worldwide. Beside the american-based NAVSTAR GPS, 
it is a russian system GLONASS, chinese system Beidou and european system Galileo. Japan is 
building a GNSS system specifically suited for the east Asian region. These GNSS systems not only 
vary in the country in which its operation centre resides and which government funds its operation, 
it also differs in the technical aspects like the frequency of the carriage wave, the number, height 
and angle (inclination) of the satellites on the Earth’s orbit, the speed in which the satellites orbit the 
Earth, number of waves they transmit and others. 
 
Where the NAVSTAR GPS signal was not ideal or better precision was required, systems for local 
enhancement of GPS, named SBAS systems, were developed. From these systems, European EGNOS 
is notable, as the predecessor of EU’s own Galileo system. 
 
Generally, an acquisition of spatial information from distance, without making a physical contact 
with the observed area, is called remote sensing. Collecting spatial data remotely involves aerial 
photography, satellite imagery or LiDAR (Light Detection and Ranging) techniques. 
 



Taking photographs from aircrafts belongs to older remote sensing techniques. The process of 
acquisition of precise survey photographs is called photogrammetry. Aerial photography can provide 
images with a high resolution, but collecting data for a large area is slow and expensive. Satellite 
images usually provide worse resolution, but a wider area can be covered. Nowadays, satellite 
images cover a whole world and are often used as base-layers in popular online maps like Google 
Maps. Recently, unmanned aerial vehicles (UAVs) allowed to take very detailed photographs of a 
small area, while being cheap. Photographs acquired using these techniques can be processed into 
orthophotos, orthophoto maps and even 3D models of terrain. 
 
Imagery from aerial, satellite and UAV photogrammetry does not have to capture visible spectrum of 
light like common cameras do. Information obtained from near-infrared, infrared and other parts of 
the spectrum are useful for applications in forestry, agronomy and elsewhere. 
 
LiDAR technique is based on targeting an object or a surface with a laser. The time travelled by the 
reflected light back to the receiver is calculated to distance. As a laser can emit the light beam to 
thousands of points in a second, the output of LiDAR is usually a large set of distances between the 
laser device and the observed object or terrain. Consequently, the distances are transformed into 
points in locations where the laser beam has been reflected. The set of these points is called a point 
cloud. A process of collecting laser data is called laser scanning. 

Quiz 

Match a spatial data acquisition technique with its description: 
⚫ Remote sensing – acquisition of spatial information from distance 
⚫ Laser scanning – capturing precise 3D information about objects or terrain in the form of 

dense point clouds 
⚫ Ground surveying – measuring of angles and distances in order to represent features by 

specific points and lines 
⚫ GNSS technique – determining precise locations on Earth by receiving signals from multiple 

satellites 

Using Maps 
 
Quality maps and accurate map use are essential in many everyday fields, including but not limited 
to: 

⚫ Navigation and Transportation: For driving directions, public transit planning, and logistics, 
maps help people and goods get from point A to B efficiently. Beyond basic navigation, 
spatial data and map data are essential in traffic management and congestion prediction 
within transportation. By analysing real-time traffic patterns and historical data on traffic 
flow, transportation departments can identify congestion hotspots, monitor traffic incidents, 
and adjust signals or implement detours to alleviate bottlenecks. Spatial data also supports 
infrastructure planning, helping planners decide where to add new roads, bike lanes, or 
pedestrian paths to improve mobility and reduce travel times across urban areas. 

⚫ Urban Planning: Maps support city planners in designing layouts for roads, green spaces, 
and utilities to optimise land use and improve quality of life. A specific example of how maps 
support city planners is the use of heat maps to identify urban "heat islands"—areas where 
buildings, roads, and infrastructure cause higher temperatures due to limited vegetation. By 
overlaying temperature data on city maps, planners can pinpoint neighbourhoods that 
would benefit from additional green spaces, like parks, green roofs, or tree-lined streets. 
This mapping not only helps reduce local temperatures and improve air quality but also 



enhances residents’ quality of life by creating cooler, more pleasant areas for recreation and 
reducing energy costs for cooling in nearby buildings. 

⚫ Disaster Management: Maps help emergency responders plan for and respond to natural 
disasters, ensuring they can reach affected areas and allocate resources effectively. An 
example is the use of flood risk maps by emergency responders during hurricane season to 
plan evacuations and allocate resources. These maps, which combine elevation data, rainfall 
predictions, and historical flood patterns, help responders identify areas most likely to flood 
and the severity of potential impacts. By pinpointing high-risk zones, emergency teams can 
prioritize evacuations, position rescue teams and supplies nearby, and set up shelters on 
higher ground. During the response, these maps are updated with real-time data, guiding 
teams to the hardest-hit areas and helping coordinate the delivery of resources like food, 
water, and medical aid. 

⚫ Agriculture: Farmers and agricultural companies use maps to plan crop layouts, manage soil 
quality, and monitor resources like water availability. A specific example is the use of soil 
nutrient maps created from satellite and drone data to help farmers manage crop layouts 
and optimise fertiliser use. These maps display varying nutrient levels across a field, allowing 
farmers to apply fertilisers only where they’re needed rather than uniformly across the 
entire field. This targeted approach, known as precision agriculture, improves crop yields, 
reduces waste, and minimises environmental impact by preventing nutrient runoff into 
nearby water sources. 

⚫ Environmental Conservation: Maps are crucial for tracking wildlife habitats, managing 
natural resources, and planning conservation efforts to protect ecosystems. For example 
migration maps, created with GPS tracking data, are used to monitor animal movements, 
such as those of African elephants. Conservationists use these maps to identify critical 
migration corridors and feeding grounds, allowing them to prioritise areas for habitat 
protection and create safe passages across human-altered landscapes. This data can also 
reveal where elephants encounter threats like poaching or habitat fragmentation. By 
understanding these migration patterns, conservation teams can work with local 
governments to designate protected areas, implement anti-poaching patrols, and establish 
wildlife corridors that connect fragmented habitats. 

⚫ Retail and Marketing: Businesses use maps to find the best locations for stores, analyse 
customer demographics, and plan delivery routes. One specific example is how Starbucks 
uses geographic information systems (GIS) to choose new store locations. By layering maps 
with customer demographic data, such as income levels, age groups, and spending habits, 
they identify areas with high potential customer density and suitable purchasing power. GIS 
also helps analyse foot traffic and proximity to other businesses, like office complexes or 
universities, where coffee demand is typically higher. 

 

Exercise 1: Creating a Soil Nutrient Map 

Objective: Use soil nutrient data to create a map in QGIS. 

Steps: 

1. Load the Data: 
 Open QGIS and create a new project. 
 Go to Layer > Add Layer > Add Vector Layer to load field boundary data (e.g. 

shapefile or GeoJSON). 
 Load soil nutrient data as a raster or tabular file (e.g. CSV with latitude, longitude, 

and nutrient levels). 



2. Visualise the Field Boundaries: 
 Right-click the field boundary layer > Properties > Symbology. 
 Choose a suitable outline or fill colour for easy visibility. 

3. Create a Soil Nutrient Raster (if data is tabular): 
 Use Processing Toolbox > Interpolate Points. 
 Select the nutrient column as the input field. 
 Choose IDW (Inverse Distance Weighted) or Kriging as the interpolation method. 
 Save the output as a raster layer. 

4. Style the Nutrient Map: 
 Right-click the nutrient raster > Properties > Symbology. 
 Select Singleband pseudocolor. 
 Set a colour gradient to represent low-to-high nutrient values (e.g. red for low, 

green for high). 
 Adjust the legend to clearly show nutrient ranges. 

5. Add a Legend: 
 Go to Project > Layout Manager to create a new layout. 
 Insert the map and a legend using the Add Legend tool. 

6. Export the Map: 
 Save the layout as a PDF or PNG for future use. 

 

Exercise 2: Analysing and Deciding Fertiliser Zones 

Objective: Use the nutrient map to identify areas for targeted fertiliser application. 

Steps: 

1. Classify the Nutrient Map: 
 Right-click the nutrient raster > Properties > Symbology. 
 Use Classified symbology to group nutrient levels into 3–5 ranges (e.g. Very Low, 

Low, Medium, High, Very High). 
2. Draw Fertiliser Zones: 

 Add a new vector layer: 
■ Go to Layer > Create Layer > New Shapefile Layer. 
■ Select Polygon geometry. 

 Use the Add Polygon Feature tool to draw polygons around areas requiring 
fertiliser. 

3. Label the Zones: 
 Right-click the new vector layer > Properties > Labels. 
 Enable labelling and set the nutrient level range as the label text. 

4. Export the Results: 
 Save the fertiliser zone layer for use in subsequent exercises. 
 Export the map layout showing the nutrient zones and recommended fertiliser 

areas. 

Course Final Quiz 

1. Match a term with its description 
 

map downscaled or simplified drawing of the earth’s surface, or part of that 



surface 

geographic data data representing features or phenomena related to the Earth 

laser scanning capturing precise 3D information about objects or terrain in the form of dense 
point clouds 

GNSS technique determining precise locations on Earth by receiving signals from multiple 
satellites 

 
2. Match an image with the most suitable description 

 

 

A projection which preserves angles but distorts 
sizes. 

 

Map legend 

 

Orthophoto 



 

Statistical map by Pierre C. F. Dupin 

 

Topographic map 

 
3. Look at the following map and answer questions: 

a. Which ecoregion is presented in yellow color? (Great Plains, Arctic Cordillera, 
Tropical Dry Forests) 

b. Which ecoregion(s) stretches most to the north? (Arctic Cordillera, Tundra, 
Hudson Plain) 

c. In which part of the continent Tropical Dry Forests can be found? (south, 
north, west) 



 
Source: Iva Brunec via X.com 


